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Introduction 

 

The Trains Style Guide for Safety, Compliance, and Training Facilitator and Participant Guides provides 

guidelines that must be adhered to in the design and development of Facilitator and Participant Guides 

produced by and for Trains. This style guide outlines standards determined by Trains to promote consistency 

across the classroom training materials. 
 
This style guide was designed to accompany the Trains brand identity guidelines. Before using this style 

guide, you should be familiar with the Trains brand identity guidelines outlined in the document entitled, Our 

Brand. This document is located on the Trains Branding page on the Trains Intranet. 
 
Other documents to be familiar with are the following: 
 

▪ Tone of Voice, which describes how to write, speak, and operate to align to the outward expression of the 

Trains personality. This document is located on the Trains Branding page on the Trains Intranet.


▪ Trains Writing Standards, which provides standards for writing training documentation. This document 

is located on the Instructional Design Center of Expertise SharePoint site.
 
After the Introduction and Overview sections, this document is organized by topic, alphabetically. Use the 

Table of Contents section to find topics quickly. 

 

 

Overview 

 

Template Format 

 

The Facilitator Guide and Participant Guide template is two files: one file for the Facilitator Guide and one file 

for the Participant Guide. 
 
Note: A PowerPoint template is available as well. 
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Required Elements 

 

Participant Guide 
 

All Participant Guides must include the following elements. 
 

▪ Confidentiality/proprietary information statement


▪ Table of contents


▪ Course overview



▪ Performance objectives


▪ How the course supports the Trains Vision, Mission, and Goals


▪ How the course supports the Trains Safety Statement
 

 

▪ Summary/review of learning objectives

 

Facilitator Guide 
 

In addition to the list above for the Participant Guide, the Facilitator Guide must also include the 

following elements: 
 

▪ Directions on how to use the Facilitator Guide


▪ Icon descriptions that facilitator will see


▪ Background information on the course


▪ Course preparation


▪ Course map (Training at a glance): each day broken down by modules, durations, lesson titles, and 

topics

 

 

▪ List of materials & preparation steps


▪ Module map (Timing & agenda): duration, lesson titles, topics, learning objectives


▪ Step-by-step directions to facilitate the course


▪ Answers to any assessment questions listed in the Participant Guide
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Template Sections 

 

The table below describes the sections of the template files. 
 
  

Section 

  

Description 

  

     
 

       
 

  About this document  Contains information about the document (creation date, version, 
 

     course number, and the department that created the guide) 
 

     
 

  Table of contents  Lists the modules, lessons, and headings (levels 1, 2, and 3) in 
 

     the Facilitator and Participant Guides 
 

     
 

  Facilitator overview  Contains information about the course for the facilitator 
 

     Not included in the Participant Guide 
 

     
 

  Introduction  Contains information about the course for the participant 
 

    
 

  Content module Contains course content; used as many times as needed to cover 
 

    the course content 
 

    
 

  Appendix Contains the Safety Briefing Guidelines; other documents/topics 
 

    can be added as needed 
 

       
 

 
 
 

Trains Logo 

 

The Trains logo represents who we are, what we do, and what we believe in. It is important to be consistent. 

When using the Trains logo, follow the Trains brand identity guidelines outlined in the document entitled, Our 

Brand. 

 

 

Captions 

 

A caption is text that appears below an image or graphic. Captions should fully explain the significance of the 

image/graphic but still be succinct. 
 
Format captions as described below. 
 

▪ Use the style FG/PG caption.


▪ Begin with a capital letter.


▪ Most captions are not complete sentences, but merely sentence fragments, which should not end 

with a period. If any complete sentence occurs in a caption, then all sentences, and any sentence 

fragments, in that caption should end with a period.

 
 
 

 

Style Guide for FGs & PGs 7 



 Trains Style Guide 
 
 

Color Palette 

 

We use a limited color palette for printed and electronic documents. The following colors are used as 

standard colors. The palette provides a reference for use the creation of text design, shapes, smart art, and 

arrows. 
 
Facilitator and Participants Guides should be printed in color (whenever possible) for use in the classroom to 

aid in learning. However, when printing for other than classroom use (e.g., reviewing drafts), print in black 

and white. 
 

Dark Blue  Sky blue 

R000  R000 

G088  G188 

B131  B226   
Light green  
R206  
G224  
B007   
Orange  
R249  
G155  
B012 

 
 

 

Module Covers 

 

The covers for the individual modules are set up differently from the guide covers. When additional content 

modules are created, module covers need to be added. 
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Document Control 

 

Versioning 

 

Documents should be versioned as you are working. 
 

▪ After updating a draft document; this increases the version by 0.1.


▪ When a document is ready to be printed for the first time or subsequent printings after updates were 

made; this increases the version by 1.0.

 

 

Version Numbers and Dates 

 

Version numbers and dates should be listed once in each module of the Facilitator and Participant Guide. A 

table has been added to the beginning of each template file to include the information shown below. 
 
 

About this document 
 

Month Year 
 

Version 
 

Course Manager: Michelle Lutz 
 

QA/QC Manager: Trent Bartholomew 
 

Developer: Insert Your Name 
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Naming Conventions 

 

Include the version number in the file name. File names should be saved in the following format, so they 

are easy identified by others: 
 
Course title_Document type_Version Number 

 

Examples: ▪ Chainsaw Safety_FG_Ver .4 
 

▪ Chainsaw Safety_JA_Starting a chainsaw_Ver .1
 
 

 

Below is a list of Document type abbreviations to use when saving training materials. 
 

Document type list 
 
 

Abbreviation Description 

 

 
 

   
 

 FG Facilitator Guide 
 

   
 

 PG Participant Guide 
 

   
 

 PPT PowerPoint 
 

   
 

 JA Job aid 
 

   
 

 RG Reference guide 
 

   
 

 QA Question and answer document 
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Facilitator Notes 

 

There are three components to the notes on the Facilitator Guide pages: 
 

 

Icons 

 
 

 

Actions  

 
 

Participant materials 

(e.g., PowerPoint slides) 
 

 

Read each courtesy point. 
 

Ask: Is there anything you would like added to the 

list? 
 

Obtain agreement on these courtesy points (e.g., by 

asking for a verbal agreement or by raising hands.) 
 

Explain that if anyone does have an issue with one 

of the items and would like to discuss it privately, 

he/she should see you before the end of the day. 
 
 

Sample facilitator notes from the Facilitator Guide 

 

Icons 

 

Icons help quickly relate what action the facilitator should be performing. The following icons should be 

used consistently in Facilitator Guides. 
 
  

Icon name 

  

Icon 

  

What the icon signals you to do 

  

       
 

          
 

  Activity     Facilitate an activity (e.g., individual, pair, triad, or whole class 
 

        activity) 
 

        
 

  Assessment     Administer an assessment (e.g., a quiz or test) 
 

        
 

  Break     Initiate a break in the instruction 
 

        
 

  Check     Check for understanding before continuing onto the next topic 
 

        
 

  Flip chart     Utilize flip chart paper 
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Icon name Icon What the icon signals you to do 

 

 
 

    
 

 Handout  Distribute a handout 
 

    
 

 Key point  Emphasize something in the content 
 

    
 

 Objectives  State the objectives of the module or of a lesson 
 

    
 

 Participant Guide  Refer to a page in the Participant Guide 
 

    
 

 PowerPoint slide  Refer to a slide in the PowerPoint presentation 
 

    
 

 Role play  Facilitate a role play 
 

    
 

 Speaker  Indicates what a guest speaker should do/say 
 

    
 

 Transition  Transition from one module or topic to another 
 

    
  

 

Actions 

 

The actions describe what the facilitator should be doing, saying, etc. Follow the guidelines below when writing 

the facilitator actions. Each action should be: 
 

▪ Concise


▪ Begin with an action verb; use bold font for the initial action verb

 

PowerPoint slides 

 

Use the last column to insert PowerPoint slides related to the facilitator’s actions. 
 

To insert slides into the Facilitator Guide, do the following:  
 

STEP 1 In PowerPoint, copy the slide from the presentation.  
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STEP 2 In Word, paste the slide in the last column of the Facilitator Guide page. 
 

STEP 3 Select the Format tab. In the Height field, type 1.2 and press Enter. 
 

The PowerPoint slide should fit in the table cell. 
 

Note: If the Format tab does not display, select the image of the PowerPoint 

slide first. 
 
 

STEP 4 Right click on the slide and select Format Picture.  
 

STEP 5 Do the following in the Format Picture window: 
 

• Select Line, then Solid line.  
• For the color, select black.  
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Facilitator Guide headings 

 

The facilitator notes are organized in a three-column table, as shown previously. Above each table should be a 

heading, which matches a heading in the Participant Guide. When a heading is used in the Facilitation Guide 

that does not have a match in the Participant Guide, add the following to the heading in the Facilitator Guide: 

(FG only). 
 

 

Fonts and Styles 

 

Trains uses Arial font in various sizes and colors for different parts of the Facilitator and Participant Guide 

templates. To keep guides consistent and increase efficiency with guide development, Microsoft Styles have 

been created for the template files. Styles define the appearance of text throughout a document and are 

found in the Styles section of the Home tab. 
 
 
 
 
 

 

Styles section of the Home tab 
 

The following specifications are for each style in the template. 
 
 

Style Size Color Spacing 

  

  
 

      
 

 Module title 36 pt White Before: 0 pt 
 

    After: 0 pt 
 

      
 

 Lesson title 26 pt Dark blue Before: 0 pt 
 

    After: 18 pt 
 

      
 

 Heading One 22 pt Dark blue Before: 24 pt 
 

    After: 0 pt 
 

      
 

 Heading Two 18 pt Dark blue Before: 18 pt 
 

    After: 12 pt 
 

      
 

 Heading three 14 pt Dark blue Before: 0 pt 
 

    After: 0 pt 
 

      
 

 Body text 11 pt Black Before: 6 pt 
 

    After: 6 pt 
 

      
 

 Captions 9 pt, bold Black Before: 6 pt 
 

    After: 6 pt 
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Bullet and Numbering Style 

 

The key characteristics of bullets are as follows: 
 

▪ Levels – Our bullet styles allow for three levels of bullets. Use the third level sparingly.


▪ Spacing – All levels of bullets are set to the specifications shown below. 
 
 
 
 
 
 
 
 
 
 
 

 

Below are the specifications for each style. The last column lists the corresponding Style name used in the 

template. 
 
  

Bullet / 

         

          
 

  numbering         
 

  styles   Description  Symbol Indent 
 

           
 

  

First level 
 

Small 
 

Winddings 
   

 

       
 

     square, 167    
 

     black  [ ▪ ]    
 

        
 

           
 

  

Second Small open Winddings 
   

 

     
 

  level square, 250    
 

    black [  ]    
 

          
 

           
 

  

Third level 
 

Dash, black 
 

Arial En 
   

 

       
 

       Dash    
 

       [ – ]    
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Formatting 

 

▪ Use bold typeface to highlight:


 Field names


 Menu paths


 Tabs


 Buttons within the document


▪ Use italic typeface to highlight:


 Screen names


 References to other sections of the document, including appendices


 References to other course titles


▪ Use brackets [ ] to enclose:


 References to keyboard buttons


▪ Underlining for emphasis is now obsolete, a relic from the typewriter are; use italics instead. Also, do 

not use underlining for headlines. Underlines should only be used


for links.
 
 

 

Graphics 

 

Per industry standards and because adults do not relate to cartoonish illustrations, do not use clip art in any 

Trains training materials. Only use graphics that are relevant; in other words, use graphics only to support the 

content. Other considerations follow. 
 

▪ Consider the size and relevance of graphics within the training materials. Size will be determined based 

on training output (e.g., Participant Guide, job aid, etc.) Small graphics can be difficult to interpret and 

difficult to read if they contain text. Giant graphics can be overwhelming.


▪ Graphics should always reinforce the words. Graphics are not necessary on every page. If a graphic is not 

needed to illustrate or reinforce an idea, do not use one. Do not make use graphics just to fill space.


▪ Keep it simple. Avoid unnecessary visual clutter, redundant labels, and other information that does not 

serve a purpose.


▪ Be consistent with the graphic effect, if any. Graphics should belong together as 

a package.
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Photographs 

 

Select photographs from the sources listed below. 
 

▪ Internet; however, ensure there are no copyright issues


▪ Take your own photographs


 When taking pictures or video of people or objects on Trains property, you must get a signature on 

the Consent and Release form.


–  Photos of employees: Uniforms must be in complete compliance with the standards manual.


–  Photos of objects: Ask the person in charge of the location to sign the form.

 

Screen Captures 

 

▪ Screen captures should always be readable.


▪ Add borders to screen captures; use the following formatting: 
 

STEP 1 Right click on the capture and select Format Picture. 

 

STEP 2 Do the following in the Format Picture window: 
 

• Select Line, then Solid line.  
• For the color, select black.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

▪ Place screen shots on the page in a logical way, taking into consideration space available, layout, 

and call out placement (see below). There is no standard for the size or placement of screen captures 

on the page.


▪ Use consistent terminology to refer to the components of a software environment. Refer to Trains’ 

Writing Standards document and Microsoft Manual of Style for Technical Publication for software 

terminology.
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Call Outs 
 

If items within a screen capture need identification, follow the specifications below for using call outs. 
 

▪ Keep arrows small. Per instructional standards, you should never use big arrows because they are 

distracting and defeat their purpose. It has been proved that end-users focus more on a big arrow than 

the actual pointed field or content.


▪ Place call outs near what they are identifying in order to use the shortest arrow possible.
 

Use colors from the color palette described in this document. Be consistent with the color(s) chosen. 
 
 

 

Headers and Footers 

 

Header 

 

The headers should include the bulleted information below. 
 

▪ Facilitator Guide or Participant Guide


▪ Trains logo
 
 

 

Footer 

 

The footer should include the following: 
 

▪ Page number


▪ Proprietary / Confidential


▪ Course Title
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Headings 

 

Effective heading are critical in getting your audience to read and navigate the rest of the document. At Trains, 

we write clear, descriptive, and concise headings. We use formats that enhance the readability and navigability 

of the writing. 
 

▪ Headings should be simple and direct.


▪ Use logical sentence structure and active voice.


▪ Avoid abbreviations and acronyms not immediately recognized by the reader.


▪ Be sure your headings are not ambiguous or have hidden, unintended meaning.


▪ Use normal punctuation as you would when writing a sentence with these notable exceptions:


 Do not end the heading with a period.


 Commas may be used instead of the word and


▪ Headings should always flush-left (not centered).


▪ For multi-line headings, break at logical intervals. Avoid splitting verbs (e.g., has increased), 

splitting hyphenated words (e.g., brand-name), and ending lines with prepositions.


▪ Use initial capital letters on the first word and proper nouns only; example:


 Correct heading capitalization: Exiting a train safely


 Incorrect heading capitalization: Exiting a Train Safely
 
 

 

Margins 

 

The cover page of both guides have the same margin settings. The margins for the reminder of the documents 

differ. 
 

▪ Facilitator Guide – half inch for top and bottom; one inch for left and right margins


▪ Participant Guide – half inch for top and bottom; one inch for left and right margins
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Objectives 

 

The Facilitator and Participant Guides include two types of objectives, performance objectives and 

learning objectives. 
 

▪ Performance objectives should be listed in the Facilitator Overview and 

Introduction modules.


▪ Learning objectives should be listed in each content module. 
 

 

Terminal objectives 

 

• A terminal objective is 
developed for each of the 
tasks selected to be 
inlcuded in the learning 
course.  

• A terminal objective is 
at the highest level of 
learning appropriate to 
the human performance 
requirements a 
participant will 
accomplish. 

 
 

 

Enabling objectives 

 

• Each terminal objective 
is then analyzed to 
determine if it needs one 
or more enabling 
objectives.  

• These supporting, 
enabling objectives 
allow the terminal 
objective to be broken 
down into smaller, more 
manageable objectives.  

• Each enabling objective 

measures an element of 

the terminal objective. 
 

 
 
 

 

All objectives should include the following: 
 

▪ Action/behavior word


▪ Condition under which the job will be done (with or without what?)


▪ Level of achievement (quality, quantity, and/or speed)
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Quick Parts Gallery 

 

The Quick Parts Gallery is used to create, store, and find reusable pieces of content. There are several 

content items that need to be created and stored in the Quick Parts Gallery in your version of Word, so that 

you can use them as needed in the template. It is important that all users of the Facilitator and Participant 

Guide templates use the selected content pieces for the Quick Parts Gallery, so that guides are consistent for 

participants and facilitators. 
 

 

Using the Quick Parts Gallery  
 

STEP 1 Open the Facilitator or Participant Guide template. 
 

STEP 2 Click the Insert tab and then select Quick Parts.  
 

STEP 3 Choose the selection from the gallery that you need. The item will be inserted into the 

document. 
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Table of Contents 

 

The table of contents (TOC) contains the titles of the modules and lessons. Within each lesson, the 

three levels of topics (FG/PG Heading 1, 2, and 3) should be included. 

 

 

Tables 

 

The key characteristics of tables are as follows: 
 

▪ Table headers


 Shading fill: Trains blue


 Font: Arial, 11pt, white


 Repeat as header row at top of each page


▪ Rows


 Arial, 11pt, black


 Spacing: 6 pt before and after


 Do not allow row to break across page


▪ Borders


 ½ pt,Trains blue


 No borders on either side of table

 

Inserting tables with Quick Tables Gallery 

 

When you need to include a table in the Facilitator or Participant Guide, use the Quick Tables Gallery. 
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